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Data Import Process 
 

Overview 
Fire departments in Arizona report their incident response activity either directly into the 
National Fire Incident Reporting System (NFIRS) or to the Office of the State Fire 
Marshal (OSFM) through eNFIRS. OSFM periodically exports the data from eNFIRS to the 
National Database. A flowchart of the process is included in Appendix A. In order to 
complete the following steps, you must have an eNFIRS user account.   
 
The general process is:  

1. Export the NFIRS incident data file from the third-party vendor software (.txt or 
.INC).  Remember to save the file in a location where it is easy to navigate to. 
NOTE: A single file can contain multiple incidents. 

2. Import the file into the eNFIRS National Data Warehouse (eDW) using the Bulk 
Import Utility (BIU) in eNFIRS 

3. Review the output reports generated by the eNFIRS import 
4. Make any necessary corrections 
5. Repeat steps 1 – 4 if corrections are made 

 

NFIRS Submission Files 
The following section outlines some of the basic elements included in an NFIRS 
submission file and is for informational purposes only. 
 
Incident Identification 
A good coding scheme is necessary when loading incidents from multiple fire 
departments from multiple states over multiple years into one database. NFIRS uses five 
key fields to distinctly identify individual incident records. 

 

 
FDID 
NFIRS relies on a five-digit identifier for the specific fire department that “owns” the 
report. This identity key is called the Fire Department Identification Number (FDID). The 
FDID number is issued and controlled by the AZ OSFM.  
The format is: CCTTN   

CC = County (01- 15) 
TT = Type of Department 
N = Order in which the department signed up 

  

Where: 
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State 
NFIRS relies on a two-character alphabetical key to identify the specific state that 
“owns” the report. The format is: SS 
 

Where  SS = State = AZ 
Date 
The incident date is defined as the date when the incident is first reported to the fire 
department.  
The format is usually: YYYYMMDD 
 
 Where  YYYY = Year 

And   MM = Month 
 And  DD = Day of the month 
 
Incident Number 
The incident number is a seven-digit number assigned to an incident (numerical only). 
This number is assigned and controlled by the fire department. 
 
Exposure Number 
In NFIRS, an exposure is a fire started by another fire. While the FDID, State, Incident 
Date, and Incident Number remain the same, a separate sequential Exposure Number is 
assigned to each exposure. The original “parent” incident is always coded as exposure 
“000” and further exposures are numbered sequentially in increments of 1, beginning 
with “001.” This is a three-digit number. 
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NFIRS Flat File Basics: 
 

 
 
More information on NFIRS Flat Files (also called “Transaction Files”) can be found on 
pages 132 – 161 of the NFIRS 5.0 Design Documentation: 
 

https://www.usfa.fema.gov/downloads/pdf/nfirs/NFIRS_Spec_2015.pdf 
 
  

0801
1 

01011 
01011 
01011 

|AZ| 
|AZ| 
|AZ| 

https://www.usfa.fema.gov/downloads/pdf/nfirs/NFIRS_Spec_2015.pdf
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eNFIRS Import 
 
To view a video created by the U.S. Fire Administration that demonstrates the 
following steps, go to: eNFIRS: Importing Incident Files (in depth) 
 
Log in to eNFIRS  
 

eNFIRS is ONLY fully functional with the Microsoft Edge browser. 
Other browsers may cause functionality issues. 

 
 
Each account can have access to multiple FDIDs, if needed. These users can switch 
between FDIDs while logged in to a single user account but will only be able to view or 
import data for the FDID profile they are currently in at that time.  
 
Select Import Incidents under Incident Management to access the Bulk Import 

Utility (BIU). 

 

  
 
 
Do NOT select “Import Fire Departments” under the “Fire Departments” section 
for the incident submission process. 

 
The first field of the Bulk Import Utility (BIU) is the email address that the results will be 
sent to. The default is the email address associated with the account, but this can be 
changed manually here if needed.  
 

 
  

Your email here 

https://www.youtube.com/watch?v=Yu5_L3qOJEM
https://nfirs.fema.gov/NFIRSWeb/login
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In the BIU, select Yes for “Accept Invalid Incidents” 
and “Overwrite Existing Incidents.” 

 
 
Note: They will turn gray when they are selected. If they are white, they are not the 
selected options. 
 
 

 
 
Select Choose File under File 1. 
 

 
 

Select the desired file and click Open.  Remember to save the files in a location that is 
easy to navigate to and you will remember where they are saved. 
 

 
 
Be sure the file follows the guidelines shown on the Bulk Import Utility (BIU) web page.  
These file guidelines are also shown in Appendix E. 
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Note: A single file can contain multiple incidents. Once the file is selected under File 1, 
click Import Files. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once you click Import Files, you will see the Bulk Import Confirmation screen. 
 
Save the original file that was imported. This may be needed to evaluate critical 
errors and/or import failures once the file import is processed and the results 
are generated.  
 

  

Your email here 

Your email here 

Your user name here 

AZ 
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The Bulk Import Confirmation does NOT indicate that the file was  

successfully imported, only that it has been successfully  

submitted to the queue for processing. 

 
The import and validation results (output files) will be sent to the email address entered 
into the Email Address field of the BIU.  
 

This email from NFIRSBulkImport@dhs.gov will contain a link to the output files. 
 

Typically, the email from NFIRSBulkImport@dhs.gov does not arrive immediately and 
may be delayed further due to a large file size or system outages.  

 

If the email from NFIRSBulkImport@dhs.gov does not arrive after 48 hours,  

contact the NFIRS Help Desk at: FEMA-NFIRSHELP@fema.dhs.gov 

 

 
 
Clicking the long link in the email will generate a message asking what to do with the 
file.  (This may look different depending on the web browser or email provider.) 
 

Your name here 

mailto:FEMA-NFIRSHELP@fema.dhs.gov
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Select “Save File” and click OK.  
 
 

  
 
Save the file to the Desktop or other desired location. This will save a *.zip folder 
containing the output files. The files in the newly saved folder are the results of the 
import.  Remember to rename the file to something that makes sense rather than the 
random letters and numbers it is assigned. 
 

 
 
More videos demonstrating eNFIRS features, such as account registration and data file 

processing can be found at the U.S. Fire Administration’s NFIRS Training web page: 
   

https://www.usfa.fema.gov/nfirs/training/  

https://www.usfa.fema.gov/nfirs/training/
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Processing Import and Validation Results 
 

Overview 
The desired result of an import is for all records to be successfully uploaded (imported) 
into the NFIRS database and to successfully pass the validation check.  
 
The folder containing the results (output files) of the import should contain four files. 
The files should have the following extensions (shown in the red box): .bad, .err, .log, 
._parsing.err 
 
The main *.log file is considered the summary report, which shows the number of 
valid imports, invalid imports (incidents with critical errors), deleted incidents, import 
failures, and the total number of incidents processed. 
 

 
 
If the file extensions are not visible, go to the View tab in Windows Explorer, click the 
“Show/Hide” menu and check the File Name Extensions box.   
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 Viewing Import and Validation Results 
 
 Open the *.zip file containing the results of the import (output files) 

 Open the *.log file and scroll to the bottom to view the Incident Summary 

 If there are zero Invalid Imports (critical errors) AND zero import failures, this 
confirms that the import and file validation was successful 

 If there are any Invalid Imports (critical errors) or Import Failures, use Appendix 
B and/or Appendix C for information on viewing these 

Summary Report (*.log) 
The following section outlines the various elements of the *.log file.  
 

The first part of the summary report (*.log) shows the settings used in the processing of 
the data. 

 
The second part of the *.log file contains a status report for each incident processed. 
Each line shows the date/time that the incident was uploaded. Alternatively, the record 
may contain other information if there are validation issues with the record or if the 
record failed to import.  

 

The third portion of the *.log file contains summary statistics for the status of the 
validation and import. Note: “Invalid imports” are incidents with one or more critical 
errors. 
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Typical Situations Found  
 
Use the information in the *.log file to determine any actions needed for the incident 
data. 

Situation 1: Successful Validation 
 
Incident Summary: 
Valid imports:         421 
Invalid imports:           0 
Deleted incidents:       0 
Import failures:            0 
Total Processed:     421 

 
The Problem:  
No problems. Invalid imports (critical errors) = 0 and Import failures = 0 
 
This is the desired outcome. All of the records successfully passed the validation check 
and were successfully imported into eNFIRS 
 

Situation 2: Invalid Imports (Incidents with Critical Errors) 
 

Incident Summary: 
Valid imports:         420 
Invalid imports:           9 
Deleted incidents:       0 
Import failures:            0 
Total Processed:     429 

 
The Problem:  
Invalid imports > 0  
There are some incidents with critical errors. 

 
Some of the records did not pass the validation check. Typically, this error message is 
generated when a data field in the record contains an invalid or incomplete value. The 
Bulk Import Utility (BIU) will still upload the incident into the eNFIRS National Data 
Warehouse (eDW). 
 
The *.err file will contain additional information concerning the validation errors.  

 
Note: Warnings do NOT impact the validity of an incident. Only critical errors need to 
be addressed. 
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In the example below, incident #0000163 was coded as a wildland fire but no acres 
were entered in the Acres Burned field.  

 
01011^AZ^20210120^0000163^0^Fire Module^Required Data^Critical^Number of Acres 

Burned^0^0^ 
 
More information on critical errors can be found in Appendix B. 

Situation 3: Import failures 
 

Incident Summary: 
Valid imports:          420 
Invalid imports:           0 
Deleted incidents:       0 
Import failures:            9 
Total Processed:     429 
 

The Problem:  
Import failures > 0  
There are incidents that failed to import. 

 
These incidents were not imported into eNFIRS.  
 
The detailed listing of the incidents in the *.log file will show “Incident failed import,” 
“Unable to import,” or “Unrecoverable error” for incidents that failed. For example: 
 
Unable to import incident 01011:AZ:05/15/2008:0000101:1 due to an error that 
occurred while saving incident data: Exposure 0 for incident number 0000101 was 
not found, but must be added before this exposure (1) can be added. (Exposure 0 
for this incident is missing or may have failed to import.) (Exposures must start 
with 0.).  2014/05/05 09:50:39 

 
 

The example above occurs when Exposure 001+ is included in the file, but Exposure 000 
is not present (or is located later in the file than Exposure 001+). Exposure 001 and 
greater cannot import if Exposure 000 is not in the eNFIRS National Data 
Warehouse (eDW).  
 
Note: All related exposures MUST have the same FDID, Date, and Incident Number. 
Otherwise, the database does not associate them together and the “child” records will 
fail to import. 
 
 
 



Page 15 of 33 

Data format issues can also cause import failures. Data formatting is typically the 
problem when there are a large number of import failures.  
 
Appendix C and Appendix D provide instructions for identifying the issues causing the 
import failures. 
 
 
When these issues are identified, refer to your fire department’s department software 
vendor, the NFIRS Helpdesk at fema-nfirshelp@fema.dhs.gov, or reach out directly to 
the AZ OSFM NFIRS State Program Manager, Stephanie Fournier at 
sfournier@dffm.az.gov for assistance.  
 
 
 
 
 

mailto:fema-nfirshelp@fema.dhs.gov
mailto:sfournier@dffm.az.gov
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Appendix A: AZ NFIRS Data Flow  

   

AZ OSFM releases all AZ 
incidents saved in eNFIRS to 

the National Data 
Warehouse Quarterly. 

The National Release of Data is typically set for July 1 
for the previous year’s data. 
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Appendix B: Using Excel to Process *.err Files 
Note: the following examples will be taken directly from CAL Fire.  You should note that when you use the examples 
below for your own use, the two letter identifier will be AZ and not CA as shown below. 
 
 Open a blank Excel workbook 

 Open the *.err file  

 Use CTRL+A to “select all” in the *.err file 

 

 Use CTRL+C to copy the selected data 

 Use CTRL+V to paste the data into cell A1 of the Excel workbook 

 

 

 Click on A in the gray column header to select all of column A 
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 Under the Data tab, select Text to Columns 

 

 Select Delimited and click Next 

 

 Check the Other box and enter either the caret (^) symbol or other delimiter, such as “|” (depending on what 
is in the file) 

 

 

 

 

 



Page 19 of 33 

 Click Finish 

 

 Your error data is now split into columns 

 Delete columns J and K, if present. 

 

 

 Click on 1 in the gray row numbers to select all of row 1 
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 Click Insert to insert a new row above row 1 

 

 Label the columns as shown below: 

 

 If desired, insert a new blank column to the left of column G, then cut and paste the Field/Location 
column (column I) into that new blank column so the information flows better (optional)  
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 The spreadsheet should now look like this: 

 

 Use CTRL+A to select all of the cells with data 

 

 Under Sort & Filter select Filter 
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 Under the Severity column filter, un-check “Warning” (since warnings do not count against validation, only 
critical errors) and click OK. 

 

 You now have a list of the critical errors from the file. 

 



Page 23 of 33 

Appendix C: Processing Import Failures 
 
 
 
 Open a blank Excel workbook 

 Open the *.log file  

 Use CTRL+A to “select all” in the *.log file 

 

 

 Use CTRL+C to copy the selected data 

 

 Use CTRL+V to paste the data into cell A1 of the Excel workbook 
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 Click on A in the gray column header to select all of column A 

 

 

 Under the Data tab, select Text to Columns 

 

  

 Select Delimited and click Next 
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 Check the Other box and enter the colon ( : ) symbol 

 

 

 Click Finish 

 

 Your error data is now split into columns 

 

 Delete rows 1 through 11 
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 Scroll to the end of the spreadsheet and delete the Incident Summary rows 

 

 

 Scroll back to the top of the document and label the columns as shown below 

 

 Use CTRL+A to select all of the cells with data 

 

 Under Sort & Filter select Filter 
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 Under the Result column filter, un-check “EXCEPTION” and “Incident was 
Successfully Imported and click OK. 

 

 Note: “Exception” indicates a critical error, NOT an import failure.  

 You now have a list of the import failures from the file. 

 More information on the incidents that failed to import can be found in the 
*.txt_parsing.err file (see Appendix D)
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Appendix D: Viewing the Parsing File (*.txt_parsing.err) 
 
The information below provides an explanation and example of identifying the formatting issues that can cause 
incidents to fail import. The parsing file is something that NFIRS-compliant software vendors should be familiar with, 
but this information can be used to assist in communication and resolution of formatting issues in NFIRS submission 
files. 

 

Elements of the Parsing File 

  

Line Number 

This is the line number, starting from top to bottom, where the data causing the import failure can be found in the 
original file that was imported to eNFIRS. Line one is a delimiter and line two is the ten-digit Vendor ID and five-digit 
Software ID. 
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Locate the specified line number in the original file that was imported to eNFIRS. 
 
Review the cause message from the parsing file and locate the data causing the import failure. 
 
This can also be found in the original file by locating the incident number and record type identified in the 
parsing file. 
 
Ex:  
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Line Number = 24 
Data = [ABCDE001211] 
 
Incident Number = 0001211 
Record Type = 1020   
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In the parsing file, the reason for the import failure in this example reads: “Numeric field exceeds max allowed 
length.” 
 
This indicates that the data (ABCDE001211) exceeds the maximum number of characters allowed for that field.  
 
To identify which NFIRS field this is, locate the element number of the data in the original file that was imported.  
 
(The element number is the count of the elements between the delimiters) 
 
Ex:  
 

 
 
Element Number = 10 
 
The NFIRS field causing the error in this example is element number 10 of record type 1020. 
 
 
 
Table 3-5 on page 132  of the NFIRS 5.0 Design Documentation lists the record types (transactions) of an NFIRS 
submission file. 
 
Record type 1020 is identified as the “Aid Given and Received Transaction” of the incident. This transaction (record 
type) contains information from the Aid Given and Received section of the Basic Module. 
 
 
 
 
 

 
 

 

https://www.usfa.fema.gov/downloads/pdf/nfirs/NFIRS_Spec_2015.pdf
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Beginning on page 141 of the NFIRS 5.0 Design Documentation, there are tables for each transaction that show which 
field is located at each element number of that record type. 
 
Locate the appropriate table based on Table 3-5.  
 
In this example, the “Aid Given and Received Transaction” can be found in Table 3-10 on page 142. 
 
From this table, it is shown that element number 10 of record type 1020 is the “Incident Number of FDID 
Receiving Aid” field. 
 
It is also shown that this field must be a number (N) and the maximum length of this field is seven digits. 
 
A key explaining the various data types can be found beginning on page 136 of the NFIRS 5.0 Design Documentation. 
 

 
 
The data causing the import failure (ABCDE001211) contains eleven digits, which exceeds the maximum of seven. 
This information can be brought to the attention of the software vendor your fire department uses to complete NFIRS 
reports (ESO, Emergency Reporting, Zoll, Firehouse, etc.) to resolve the issue in their data formatting. 
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Appendix E: eNFIRS Bulk Import Utility (BIU) File Guidelines 
 
These guidelines can be found on the eNFIRS BIU web page: 
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